
 
2018 Update 1 Release Summary 

Overview 
Version 2018 is major release that includes enhancements as well as customer requested 
software modifications and corrections. Corrections for 2015 Update 1 and Update 2 are included 
with this release.  The emphasis of this release is enhancements to the drafting and detailing 
capabilities of ExpertCAD.  This release summary briefly describes the software changes for this 
release. 
 
Platform Support 
The table below lists the certified and supported operating systems for 2018.  The full regimen of 
quality assurance testing has been performed on these platforms and any problems or defects 
with AMT software related to the operating system will be repaired: 
 

Operating System 32-bit 64-bit Minimum Revision Level 
Windows 10   All (Windows 10 S not supported) 
Windows 7   Service Pack 1 

Windows Server 2016 N.A.  All 
Windows Server 2012 N.A.  R1 & R2 

        
Notes: 
 
The software will likely install and run on Windows 8, 8.1 and Windows Server 2008 
however these operating systems are not formally supported.  Quality assurance testing 
was not performed for these operating systems for the 2018 release.   
 
The software will not install or run on operating systems older than Windows 7 (e.g. 
Windows XP).  
 
Windows 10 S is not supported.  Windows 10 S only runs apps from the Microsoft 
store. 

 
During installation, a log file is generated in the user’s temp directory.  For example, if 
you are logged in as Administrator, the file: 
C:\Users\Administrator\AppData\Local\Temp\ExpertCAD_FinishInstallLog.txt 

is created to record the finishing steps unique to installing AMT software.  If you 
encounter any problems with installation, please forward this file along with a 
description of the nature of the problem to:  support@amt-software.com. 
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Installation, Licensing and Compatibility 
This release is installed as though it is a new application.  It is not necessary to remove any older 
version from your computer.  The installation program will not overwrite any applications 
programs from previous installation(s).  A separate program group is created and shown in the 
Windows start menu: 

 

This Windows 7 computer has older versions 
of ToolDesigner installed side-by-side with the 
ToolDesigner 2018 release. 

 
There are no changes to licensing for this release.  Your current licenses for ToolDesigner 2015 
are compatible with 2018.  You do not need to do anything with regards to licensing to run the 
new release provided you are upgrading from 2015.  If you are upgrading from a release prior to 
2015, you will new software license. 
 
Important Note:  ExpertCAD writes a new version of the native binary file format.  This means 
that earlier versions of ExpertCAD cannot read files written by 2018. 
 
 
ExpertCAD & ExpertCAM Program Group - Start Menu 
A new program – Batch Translator – has been added to the ExpertCAD & ExpertCAM program 
group.  The batch translator allows conversion of multiple files from one file format to another. 
 
ExpertCAD View is a new program in the ExpertCAD/ExpertCAM program group.  ExpertCAD 
View is the same program as ExpertCAD with the ability to write files is disabled.  ExpertCAD 
View is a licensed application.  The program will not function properly unless you have a valid 
ExpertCAD View license available. 
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AutoCAD Translation 
 
Support for reading and writing AutoCAD 2018 & 2019 files has been implemented for this 
release.  AutoCAD 2018 introduced a new revision of the DWG file format that could not be read 
by previous releases of ExpertCAD and ExpertCAM. 
 
When translating AutoCAD blocks and block references to ExpertCAD, the symbols for the blocks 
are renamed in cases where they contain one or more characters that are incompatible with 
ExpertCAD symbol names.  Invalid characters such as the ‘$’ will be changed to the ‘_’ character 
to ensure compatibility. 
 
AutoCAD files output from Autodesk Inventor that contain block references can now be imported 
into ExpertCAD. 
 
The text formatting code ‘\T’ in text entities exported from AutoCAD is correctly translated.  
Previous versions would translate the ‘\T’ as literal text. 
 
When detecting the drawing standard for an AutoCAD drawing, the translator has been revised to 
inspect the entities in all layouts as well as model space.  In certain cases there are no indicators 
in model space however the layouts do have information regarding the proper standard to 
choose.  Previous versions would only consider entities in model space to deduce that the 
appropriate drawing standard should be. 
 
Additional error checking has been added to the AutoCAD to ExpertCAD translator to look for 
improperly formed crosshatch entities.  Previous versions would crash when a crosshatch entity 
without a closed boundary was encountered. 
 
When converting AutoCAD to ExpertCAD, the translator will properly record the revision level of 
the translator that produced the ExpertCAD file.  Previous versions would always record Version 
7.6. 
 
A problem translating certain dimensions with tolerances in AutoCAD to ExpertCAD format has 
been corrected: 

 
                       Dimension in AutoCAD   Dimension translated in 2015 
Stacked tolerances such as this will convert successfully when read into ExpertCAD 2018: 

 
Results in 2018 

 
Importing AutoCAD drawings with one or more layouts (paper space) could result in stray lines 
appearing in the layout.  This has been corrected so that when the model space data is projected 
into the layout, any entities not entirely contained within the layout are omitted. 
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Color change escape sequence (e.g. \C1;) in an AutoCAD text note was not being recognized.  
This has been corrected such that the text note will appear in the color specified by the first 
escape sequence encountered. 
 
Support has been added for common symbols found in AutoCAD files.  Specifically the Euro, 
micro, angstrom, plus/minus, diameter and degree symbol were not converting properly.  This 
has been addressed in 2018 so that these symbols are properly translated. 
 
Polyline entities in AutoCAD use a bulge factor to represent arcs.  In discrete cases where the 
bulge factor is less than 1.0e-6, the translator would create an arc with an impossibly large radius.  
This has been changed so that any factor less than 1.0e-6 is handled as though the bulge factor 
was 0.0.  This appears to be the correct interpretation in AutoCAD as well. 
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Text Notes in ExpertCAD 
 
The text icons have dramatically changed in 2018: 
 

  
Text icons in previous versions of ExpertCAD. ExpertCAD 2018 text Icons 

 
 
Setting the Characteristics of the Note 
 
All icons that place text on the drawing offer a similar dialog: 
 

 
Text Dialog in 2018 

5 



The top part of all dialogs posted allows you to change the characteristics of the text (font, color, 
size, angle, justification, ….).  This eliminates the need for separate icons to change font, 
character height, angle, color, line style and justification.  Because of this, the icons for changing 
these characteristics have been removed.  Depending on the function of the icon, you can easily 
enter a predefined text note from the pull-down menu in the dialog. 
 
Leader Notes and Balloon Notes 
 
The leader note wheel icon has been removed.  The different style of leader and balloon notes 
possible are now separate icons.  The leader notes you can place on the drawing and their 
associated icon is shown in the table below: 
 

   

  

 

 
 
The Split Balloon icon will allow either the top or bottom half of the balloon note to be empty. 
 
 
Find and Replace Text 
 
Find and Find and Replace icons have replaced the former Find icon: 
 

  
The Find Text icon in previous releases. Replaced by Find and Find and Replace icons. 

 
Find and Replace is a new feature that can find text and optionally replace it or replace all 
occurrences of the text on the drawing: 
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Datum Feature Note 
 
Datum Feature text note icon has been added to the text icons to create a datum feature note at 
the location of the current point: 
 

 

 

 

 
 
 
 
 
Datum Feature Symbol Note 
 
The datum feature symbol note icon creates a note to identify a surface or feature of size as a 
datum.  A 2 point current line is a prerequisite.  The 1st point indicates the surface or feature of 
size and the 2nd (current point) indicates the location of the note.  The leader line will always be 
made perpendicular to the line or arc nearest the 1st point of the line. 
 

 

Create a 2 point 
line.  The 1st point 
indicates the 
surface or feature 
of size.  The 2nd 
point is where to 
place the text. 

 

Choose the datum 
feature symbol 
note icon. 
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Establish the 
characteristics of 
the note and 
choose (or enter) 
the datum text in 
the datum 
identifier dialog. 

 

Results.  Note that 
the leader will be 
perpendicular to 
the feature 
nearest the 1st 
point of the 
current line.   

 
 
Datum Target Note 
 
The datum target icon allows you to create datum target notes.  A 2 point line is a prerequisite.  
The 1st point indicates the target and the 2nd point indicates where the note should be placed.  
The datum target dialog offers many options for creating the note. 
 

 
 
Here are some examples of the different types of datum target notes possible: 
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Dimensioning in ExpertCAD 
 
Leading and Trailing Zeros 
 
A new option has been added to the Tools/Options/Dimensions property sheet to format 
dimensions such that trailing zeros are kept or omitted. 
 

 
 

  
Trailing zeros enabled. Trailing zeros disabled. 

 
Changing Leading zero or Trailing zero affects all dimensions on the drawing. 
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Dimension Formatting Dialog 
 
A new dimension text dialog has been implemented for this release.  Choosing any of the 
dimension formatting icons causes the dimension format dialog to be posted: 

 

 

 
 

New Dimension Format Dialog 

 
Choose a prefix, a dimension format and a suffix for the dimension you wish to create.  The prefix 
and/or suffix can be empty. 
 
Once you have set the dimension prefix, format and suffix, check the dimension types this format 
should apply to.  In the example above, we want diameter dimensions only to have a prefix of 
consisting of the diameter symbol with 3 decimal places of accuracy.  When you click OK, all 
newly created diametrical dimensions will conform to this format: 

 
In a similar fashion, you can setup how you would like linear dimensions, radial dimensions and 
angular dimensions to appear on the drawing.  Each can have their own particular format.   
 
If you wish to do dual dimensioning, enable the dual dimensioning check box and choose a 
format from the drop-down menu.  Side-by-side with brackets or parentheses or over-under with 
the brackets or parentheses method are supported: 
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Examples of Dual Dimension Formats Possible 

 
 
Dual Dimensions with Tolerances 
 
Dual dimensioning with tolerances is correctly supported.  In previous versions, specifying a 
tolerance with a dual dimension format did not output the proper dimension text. 
 

 
Toleranced Dual Dimension Examples 
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Geometric Tolerancing Feature Control Frame 
 
Creating a geometric tolerancing feature control frame has been completely revamped.  The 
series of prompts in the message area has been replaced with an easy to use dialog offering 
more features and functions. 
 

 

 

 
 

Geometric tolerancing icon posts this new dialog to create the feature control frame. 
 
A current point is required to indicate the position of the frame.  If you use a 2 point line, a leader 
can be added to the feature control frame according to the style you wish.  The first point is where 
to place the arrow, the 2nd point (current point) will be the center of the frame: 
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Importing 3D Files into ExpertCAD 
 
Importing native ExpertCAD 3D files, files in 3D PDB format and 3D IGES files is supported in 
ExpertCAD.  If an input file is a 3D model, the file will be imported showing 4 standard views of 
the 3D data: 

 
             A mold design in ExpertCAD 3D written to disk in the native ExpertCAD 3D format…. 

 
            Opening the native ExpertCAD 3D file in ExpertCAD results in 4 standard views of the 3D design. 
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In the Tools/Options/Import Export property sheet, you can specify how 3D surface data should 
appear when projected into 2D: 
 

 
 
Draw silhouette edges causes the translator to draw each surface in each view such that the 
silhouette edge of the surface is drawn.  Enabling this switch will increase the amount of time it 
takes to translate a 3D  file into 2D as the edges must be calculated during translation. 

 

On the left is a cone imported with the silhouette edges switch disabled.  On the right is the same cone with the 
switch enabled.  Note how the exact edges of the cone are clearly visible when the switch is enabled. 

If the Draw surface flow lines switch is enabled, additional lines interior to the 3D surfaces are 
projected into the 2D views to better show the shape of the surface in 2D.  The number of flow 
lines is configurable and applies to all surfaces imported. 

 

If Draw surface flow lines is disabled, a cone is imported into 2D as shown on the left.  Enabling the switch will 
add interior flow lines as shown on the right. 
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Preview of ExpertCAD Files 
 
In Windows Explorer and the File Open dialog, a preview of ExpertCAD drawing files is 
supported.  The Preview Pane option must be enabled and only files with the ‘.ddd’ extension are 
recognized by the Windows operating system as being subject to a preview: 
 

 
 
When you click on a file name that is an ExpertCAD drawing with the file extension ‘.ddd’, a 
preview of the drawing will appear in the preview pane: 
 

 
Windows Explorer 

 

 
File Open Dialog 
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Free Upgrade from ExpertView to ExpertCAD View 
 
ExpertView has been discontinued.  If you have licensed ExpertView, install ExpertCAD on your 
computer and choose ExpertCAD View from the start menu.  Your current ExpertView license will 
permit you to run ExpertCAD View. 
 
ExpertCAD View is ExpertCAD.  All the features and functions of ExpertCAD are available with 
the exception of saving drawings to disk.   
 
New Batch Translation Program 
 
A new program – Batch Translator – allows you to convert multiple files from one format to 
another.  This is a stand-alone application program that can be run from the Windows start menu 
or from ExpertCAD: 
 

 

 

 

Start the Batch Translator from either the Windows Start menu or from within ExpertCAD 
 
The batch translator program supports the following translations: 
 
From: AutoCAD DWG (*.dwg) to ExpertCAD (*.ddd), AutoCAD DXF (*.dxf), IGES (*.igs) Adobe PDF (*.pdf) 
From: AutoCAD DXF (*.dxf) to ExpertCAD (*.ddd), AutoCAD DWG (*.dwg), IGES (*.igs) Adobe PDF (*.pdf) 
From: ExpertCAD (*.ddd) to AutoCAD DWG (*.dwg), AutoCAD DXF (*.dxf), IGES (*.igs) Adobe PDF (*.pdf) 
From: IGES (*.igs) to ExpertCAD (*.ddd), AutoCAD DWG (*.dwg), AutoCAD DXF (*.dxf), IGES (*.igs) Adobe PDF (*.pdf) 
 
Discrete files or entire folders and sub-folders can be translated as a batch process.  A logging 
capability tracks the progress and results of each translation.  For more information, click the Help 
button. 
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Deleting Duplicate Entities 
 
A new option in the Tools/Purge menu has been added to delete duplicate entities in a drawing: 
 

 
Choosing Purge Duplicate Entities will remove duplicate entities.  A duplicate entity is defined as being 
exactly the same (e.g. same layer, color, line style, number of points, size and position, ….).  The results of 
the purge operation will be reported in the message area. 
 
ExpertCAD Graphics 
 
New graphics methods have been implemented in ExpertCAD for drawing text and lines to the screen.  The 
result is 3-4X faster redraw times for large drawings.  This also corrects and issue that affected certain 
graphics hardware that could result in an infinite sequence of redraws. 
 
Ordering has been added to the way entities are redrawn.  Entities that are selected are always drawn last.  
this way it is always clear what is selected and what is not in cases where entities totally or partially overlap. 
 
New Class Definition for Circles and Holes 
 
There are 2 new classes to identify circles and holes on a drawing: 

circles <radius> 
holes <diameter> 

These classes return all lines that are full circles of the specified radius or diameter. 
 
More User Preferences 
A switch has been added to the Tools/Options/User Preferences property sheet to reverse the 
direction of the mouse scroll wheel.  Scrolling the wheel forward (away from you) zooms out; 
backwards (towards you) zooms in.  Enabling this switch reverses the direction: 
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Icon tracking speed has been corrected to properly track the icons regardless of the speed you 
wish to set.  In the Tools/Options/User Preferences, icon tracking is represented as an integer 
pull down menu with a range from 1 (slow) to 20 (fast).  When you track the icons, movement of 
the pointer is temporarily changed by Windows to be the same as though you changed it through 
the Windows Control Panel/Mouse dialog.  When you are finished tracking the icons, the pointer 
speed is reset to your original default set in Control Panel: 

 
Icon Tracking Speed in Tools/Options/User Preferences performs the same function as the Motion control in the 
Windows Control Panel.  The speed set is only in effect when tracking the icons. 

 

Remote Display Support 
Previous versions of ExpertCAD and ExpertCAM did not allow the use of the software in a 
client/server environment using Microsoft Remote Desktop (RDP) or other remote display 
technologies (UDP).  This type of usage is now permitted provided the server (computer that the 
software is running on) is not running Microsoft Windows Server as the operating system.   

 

Maintenance 
ExpertCAM 

When post processing from ExpertCAM, the software could produce an invalid error that the CL 
data file could not be written to disk.  This has been corrected to properly check if the CL data file 
was created. 

Configurable post processors that use an event file to format floating point numbers for output 
could produce scientific notation: 
 G76G98X0.Y0.Z-5.1R-.5F8.I-1.e-002 
This has been corrected so that scientific notation is never output because most CNC controls 
can’t evaluate a floating point number that is expressed like this. 

A discrete case where an ExpertCAM program produces an illegal offset error has been 
corrected.  In certain circumstances where the offset for the tool and the stock allowance was 0.0 
this error would be issued instead of producing the proper cutter path. 

A log file is created when post processing from ExpertCAM to record any errors that may have 
occurred during processing.  One of 3 log files in the users temp (%TEMP%) directory are left 
behind: 

File Name Purpose 

postrun.log This is a log file from ExpertCAM that has the command that was 
run to call the post processor.  

cimpostm.log If a mill configurable post is run, this log file is created to record 
what happened during processing of the CL data file. 

cimpostl.log Same as cimpostm.log but for lathe post processors. 

 

The configurable post processor program has been corrected to prevent a program crash if 
presented with a CL data file that is not in the correct format.  The post processing software has 
been corrected to inspect the CL data file for correctness before attempting to process it. 
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ExpertCAM will no longer add a file name to the recent files list in the File menu when the chosen 
file could not be read by ExpertCAM. 

The Tools/Options/User Preferences property sheet for ExpertCAM has been modified to include 
a button to change the font for the graphics area: 

 

 

Choose whatever font, font style and size you wish for the display of section numbers, span numbers and all 
other text in the graphics area for ExpertCAM 

 

If your mouse has a tilt-wheel, that function is now supported in ExpertCAM.  Pushing the wheel 
to the left or right will shift the view in that direction by ¼ of the current display.   

 

ExpertCAD 

When reading or writing files to disk, the files are now opened such that they are locked by the 
process that opened the file.  No other process can access the file while it is being read from or 
written to.  Previous versions would open the file with shared access rights.  This could cause a 
read or write operation to unexpectedly fail if another process (e.g. anti-virus software) accessed 
the file concurrently. 

The dialog for choosing one or more symbols to set the current class has been revised to better 
show the symbol(s) chosen in the graphics area.  All symbols chosen are highlighted at once 
instead of in the sequence they were picked.  This makes it easier to see what entities are in the 
class. 

The ExpertCAD to IGES translator has been revised to never leave behind an unwanted 
temporary file.  Any temporary files are now created in the users %TEMP% directory and deleted 
upon completion of the translation. 

A correction to the ExpertCAD to IGES translator was implemented to prevent it from creating a 
single point line that is not a point line.  Single point lines are now output correctly output as point 
entities. 

The ExpertCAD to IGES translator now supports the translation of drawings created with the 
drawing standard set to BS8888.  Previous versions did not properly support this drawing 
standard. 
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IGES files that omit the start section were not recognized as valid IGES files.  This has been 
corrected so that files that begin with the globals section (start section omitted) are considered 
valid IGES files. 

The default plotcap.txt file used in conjunction with WinPlot has been updated to include the 
proper codes to handle the plotting of TrueType fonts.   

If the format of a file to be opened in ExpertCAD can’t be determined because the file is corrupt, a 
proper error message is output in an error dialog.  Previous versions would not handle this 
situation properly and would output a confusing error message. 

The scale and .scale primitive command in ExpertCAD have been revised to use a point on the 
geometric stack if there is not a current point to indicate the origin for the scaling operation.  This 
is consistent with the other transformation primitive commands such as rotate. 

Changing the drawing standard in ExpertCAD now updates the status bar immediately to show 
the standard in effect.   

The behavior of the flatten command has been corrected so that hidden crosshatch, dimensions 
and calls to symbols will remain hidden after being decomposed into simple line and text entities.  
Previous versions would cause the flattened representation of these entities to become visible. 

When using the flatten command in ExpertCAD to decompose point lines (style 31 or style 64), 
the resulting lines will all be single point line entities.  Previous versions would result in 2 point 
lines when multi-point point lines were flattened. 

An incorrect error message was being output when you attempted to open a file in ExpertCAD 
that is locked by another process.  The correct error is now presented in an error dialog: 

 
 

A new geometric stack primitive command has been added to allow you to find a parametric 
position along a geometric entity. 

pt-from-t <parametric position 0.0 to 1.0> 

This command pops a geometric entity off the top of the stack and pushes a point onto the stack 
that represents the parametric position of the along that geometric entity.  For example, if there is 
an arc on the geometry stack, the command pt-from-t .5 will pop the arc off the stack and push 
a point onto the stack that has the coordinates of the midpoint of the arc. 

When measuring an arc in  ExpertCAD, the sweep angle of the arc is now reported along with the 
other characteristics of the arc in the message area: 
Arc center = X: -74.511607 Y: 2.002551 Radius: 0.184728 Diameter: .369456 Dir: clockwise 
Length: 0.408261 Start angle: 152.635647 End angle: 26.008304 circumference: 1.160681 
Sweep angle: 126.627343 
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In the Tools/Options/File I/O property sheet, an option has been added to let you determine 
whether or not you wish to replace or append an extension to a file name: 

 
If you are currently editing a file named Part88.ddd and you export the data to DXF format, the 
default name for the DXF file will be Part88.ddd.dxf.  If you enable the switch to replace the file 
extension, the default name would be Part88.dxf (the .ddd extension is replaced). 

The number of recent files opened in the File menu can be set in the Tools/Options/File I/O 
property sheet: 

 
Setting Recent Files to zero will disable the recent files feature in the File menu. 

The Purge Empty Layer Names in the Layer Manager dialog has been repaired to work correctly 
in the event that the same layer name is used for 2 or more layers.  Previous versions could end 
up deleting the wrong layer name if duplicate names were used. 

The limitation of only being able to create 256 model views in ExpertCAD has been lifted.  Any 
number of model view entities can be created. 

Error checking has been added to the prompt for upper and lower tolerances for dimension 
creation in ExpertCAD.  Non-numeric responses are rejected and the user is prompted to try 
again.  
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Additional glyphs have been added to the native ExpertCAD fonts to support symbols entered 
from the keyboard.  Windows lets you enter a symbol by holding down the Alt key then pressing 
in sequence a series of numbers on the keypad (note – you must enter the numbers from the 
number keypad on your computer).  When you release the Alt key, the symbol is entered.  The 
following glyphs have been added to support these symbols: 

 

Entering the symbols using the 
Alt key and number sequence 
from the number keypad…. 

 

 

… resulting text note in 
ExpertCAD 2018. 

On installation of ExpertCAD 2018, the new glyphs will automatically be added to your font files if 
they have not already been defined. 

The File/Properties dialog has been modified to make the fields Last revised by: and Last revision 
on: read-only.  The ExpertCAD software keeps track of the login that last revised the drawing and 
when the revision was made and would overwrite any changes made.  These fields are now read-
only. 

When ExpertCAD is set to the DIN drawing standard, the thumb wheel icon for switching to 
theoretical, nominal and check dimensions was not working properly.  An error was emitted 
instead of properly setting the dimension type. 
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Importing CL data files from ExpertCAM or Prospector into ExpertCAD is now supported.  Rapid 
motion is output in red as a dashed line.  Feed motion is output in blue as a solid line.   

 

General 

The handling of interrupts (Esc key) has been corrected to propagate the interrupt to throughout 
the call sequence.  Previous releases would not properly handle an interrupt if a modal dialog 
was posted when the interrupt occurred.   

The ScriptLink calculator command (‘=’) has been corrected to handle a unary ‘+’ in an 
expression.  Previous versions would output a syntax error is an expression such as +4/2 was 
entered. 

The ScriptLink string formatting functions have been modified to correctly output floating point 
numbers that are 0.0.  In previous versions, if the internal floating point number was 0.0 but the 
sign bit was set, the value would be output as -0 or -0.0.  This has been corrected so that the 
negative sign is never output if the value is zero. 

The Help menu for ExpertFont and ExpertIcon has been corrected to bring up the correct help 
HTML document in your browser. 

A text buffer SCROLL_SMENU allows the value ‘0’ to disable the scrolling of the on-screen icons 
on the right of the screen.   

Modification of the Start in folder for a program in the ExpertCAD program group will now be 
honored.  In previous versions, programs would always start in the user’s Personal Folders 
directory regardless of the setting. 
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ExpertView LE 
ExpertView LE is a free view, measure and markup application available to all customers with 
maintenance contracts: 

 
ExpertView LE 

ExpertView LE has a minimal user interface that is so simple that anyone can quickly learn how 
to use it to view drawings.  Any type of drawing ExpertCAD can read, ExpertView LE can read 
including AutoCAD drawings.  This software installs and runs on any computer that is capable of 
running ExprtCAD including tablet computers.   

You can download ExpertView from the AMT Customer Portal:  
http://www.amt-software.com/CustomerPortalEntry.html 

 

Resolved Software Requests 
When you report a problem or request an enhancement, our customer service representative will 
input your request into our software lifecycle management system and give you an ID number. 
Listed in the table below are the ID number and a synopsis of each record from our system that 
has been discharged for this release. 
 
Record ID  Customer Synopsis  

SRX00090 AMT In the user %TEMP% directory, record the program name and command line options 
used to translate a file from one format to another. 

SRX00140 AMT Add a class to reference all circles on a drawing. 

SRX00141 AMT Revise the installation programs to not register the files and folders installed under the 
ProgramData folder. 
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SRX00169 AMT Honor the Start in folder for the shortcuts in the Start menu for a program group. 

SRX00176 AMT Modify the AutoCAD to ExpertCAD translator to automatically rename blocks to avoid 
conflicts with ExpertCAD symbol naming conventions. 

SRX00184 AMT Add the ability to preview an ExpertCAD drawing in Windows Explorer and the File 
Open dialog. 

SRX00196 AMT Add ExpertCAD View to the program group. 

SRX00205 gromaTec Surface trimming in ExpertCAD 3D is not producing a smooth surface in this discrete 
case. 

SRX00206 K&S Tool Die & 
Manufacturing 

Disable the AutoCAD export menu if there are no entities in the class to write in order to 
avoid creating zero length files. 

SRX00211 Thumb Tool & 
Engineering Importing DWG files from Autodesk Inventor is not working. 

SRX00212 Thumb Tool & 
Engineering 

The text formatting code ‘\T’ is not being translated properly when importing this 
AutoCAD file.  

SRX00213 Thumb Tool & 
Engineering 

Improperly formed crosshatch entity in this AutoCAD files is causing the translator to 
crash. 

SRX00214 AMT An incorrect error is being published when trying to open a file locked by another 
program or process. 

SRX00217 gromaTec Purge of layer names with no entities is not working properly if 2 or more layers have the 
same name. 

SRX00218 Thumb Tool & 
Engineering Icon tracking speed control is not working properly in the user interface. 

SRX00219 Thumb Tool & 
Engineering 

Add an option to append or replace a file extension when writing files of a different 
format. 

SRX00220 AMT Add a geometric stack command to return a point at a parametric position along a 
geometric entity on the stack. 

SRX00220 AMT Clicking on the Window close button on the About dialog causes the license information 
dialog to display instead of closing the About dialog. 

SRX00224 AMT Add an option to reverse the effect of the mouse wheel. 
SRX00225 AMT Report the swept angle when measuring an arc in ExpertCAD. 

SRX00226 AMT Add the ability to import ExpertCAD 3D files, PDB files and 3D IGES files into 
ExpertCAD. 

SRX00227 Federal Dual dimensions (inch & metric) does not work correctly if a tolerance is used. 

SRX00229 AMT Cursor appearance is not restored if the parting line function is interrupted in ExpertCAD 
3D.  It remains in a wait state. 

SRX00230 AMT Add the ability to convert multiple files from one format to another. 

SRX00231 AMT Handling of interrupts within ScriptLink is not being handled properly when macro(s) are 
run from a Windows dialog. 

SRX00232 AMT Exporting 2D data from ExpertCAD 3D does not show the correct extent of the surfaces 
in all views. 

SRX00233 K&S Tool Die & 
Manufacturing Looping redraw when opening larger dxf/dwg files in ExpertCAD. 

SRX00235 AMT When redrawing the screen, ExpertCAD doesn’t stop redrawing when you wish to 
choose a menu.  You have to wait for it to complete. 

SRX00236 AMT Interrupts (Esc key) are not being handled correctly in this instance. 
SRX00238 gromaTec This AutoCAD .dwg file will not read into ExpertCAD. 
SRX00239 AMT Text in the title block of this AutoCAD file is incorrectly sized when read into ExpertCAD. 

SRX00243 AMT The ‘$’ character in block names for AutoCAD files is causing problems with translation 
to ExpertCAD. 

SRX00241 AMT Add an audit capability to the AutoCAD to ExpertCAD translator. 
SRX00242 AMT The dialog for setting up a class of calls to specific symbols works poorly. 

SRX00243 AMT Include information more information in the error file produced by the AutoCAD 
translators to better understand the cause of any failure. 

SRX00245 AMT Converting an ExpertCAD file to IGES can leave behind an unwanted temporary file. 
SRX00246 AMT The ExpertCAD to IGES translator does not support BS8888 standard drawings. 

SRX00247 AMT The AutoCAD to ExpertCAD translator is not recording the correct version of the 
translator that produced the ExpertCAD file.   

SRX00250 AMT The default plotcap.txt file is not correct with regards to plotting TrueType fonts. 
SRX00251 AMT An incorrect error is output when trying to open this corrupt AutoCAD file. 

SRX00252 Manitowoc 
Cranes Add the ability to disable the scrolling of the icons on the right hand of the screen. 

SRX00255 AMT The ‘flatten’ command in ExpertCAD can cause some entities that were hidden to 
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become visible. 

SRX00256 AMT The scale primitive command in ExpertCAD should work in a manner consistent with the 
rotate command; use a point on the geometric stack if there isn’t a current point. 

SRX00258 AMT Clicking the Cancel button on the dialog for Add Text in ExpertCAD causes the text to 
be added to the drawing anyways. 

SRX00259 AMT Changing drawing standard in ExpertCAD does not immediately update the status bar to 
show which standard is now in effect. 

SRX00261 Thumb Tool & 
Engineering 

When reading or writing ExpertCAD files, open the disk file in a locked state instead of 
shared access rights. 

SRX00262 Thumb Tool & 
Engineering Add an option to enable or suppress trailing zeros for dimensions in ExpertCAD. 

SRX00263 AMT Checking for the existence of a CL data file when post-processing from ExpertCAM is 
not correct. 

SRX00264 Thumb Tool & 
Engineering An AutoCAD tolerance dimension in this DWG file is not being translated correctly. 

SRX00265 Thumb Tool & 
Engineering Stray lines are appearing in one of the layouts for this AutoCAD drawing. 

SRX00266 Thumb Tool & 
Engineering Stray lines are appearing in one of the layouts for this AutoCAD drawing. 

SRX00267 Fairbanks Morse A configurable post processor with an event file is generating scientific notation for 
output.  This numeric format can’t be read by the CNC. 

SRX00270 Fairbanks Morse This CAM program is producing an illegal offset error. 
SRX00275 AMT Leave behind a log file that tells what happened when post processing from ExpertCAM. 

SRX00276 AMT The configurable post processing subsystem will crash if presented with a CL data file 
that is not in the correct format. 

SRX00277 AMT Do not add a file to the recent files list in ExpertCAM if the file can’t be read. 
SRX00278 Pall Add the ability to disable the recent files feature in the file menu for ExpertCAD. 

SRX00280 Thumb Tool & 
Engineering 

The AutoCAD to ExpertCAD translator does not determine the drawing standard 
properly for this DWG file. 

SRX00281 gromaTec Parentheses are not handled correctly for dimension descriptors in ExpertCAD 3D. 
SRX00282 AMT Revise the way we setup dimension text in ExpertCAD. 
SRX00283 AMT Add missing glyphs to the ExpertCAD native fonts for various symbols. 

SRX00285 AMT Revise the user interface for entering geometric tolerance notes in a feature control 
frame. The current method is out of date and not fully featured. 

SRX00286 AMT The Help menu for the font editor ExpertFont and icon editor ExpertIcon still reference 
the old .pdf help files. 

SRX00287 AMT The flatten command is not working correctly for point lines. 

SRX00289 AMT Layer names in ExpertCAD 3D are not being saved to the 2D drawings when exporting 
to ExpertCAD using the Mold Drawings feature of Export feature. 

SRX00290 gromaTec The purge feature for empty layer names is not working properly. 
SRX00291 AMT Allow ExpertCAD View to run if there is an ExpertView license available. 
SRX00292 Fontaine Allow ExpertCAD to run in a client/server environment. 
SRX00294 AMT Add support for read & write of AutoCAD 2018 files. 
SRX00295 AMT Honor a color change escape sequence when converting AutoCAD text notes. 

SRX00296 AMT Add support for symbols commonly found in AutoCAD files so they convert properly 
when read into ExpertCAD. 

SRX00299 AMT Add a feature or program that will allow for the batch translation of many files from one 
format to another. 

SRX00300 AMT Add Replace and Replace All to the Find Text dialog in ExpertCAD. 

SRX00301 AMT Record in the ExpertCAD file if the file was created as a result of translating from one file 
format to another. 

SRX00302 AMT Allow for more than 256 model views to be created in ExpertCAD. 

SRX00303 AMT The Last revised by and Last revised on in the File/Properties dialog in ExpertCAD 
should be read-only. 

SRX00304 AMT Record the drawing properties in the ExpertCAD binary file when it is first created or 
subsequently written to disk. 

SRX00305 AMT The IGES to ExpertCAD translator can output a 1 point line that is not a point line style.   
SRX00306 AMT A polyline entity in this AutoCAD DWG file is not translating properly to ExpertCAD. 
SRX00308 Bernal Add a Preview capability to Windows Explorer for ExpertCAD files. 
SRX00309 Bernal Add a Preview capability for the File Open dialog in ExpertCAD. 
SRX00310 ITW Drawform Add the ability to set the size of text in ExpertCAM. 
SRX00311 AMT Prevent the output of -0 (or -0.0) when formatting floating point numbers for output in the 
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message area and display in dialogs. 
SRX00314 AMT The scale command doesn’t handle the case of a malformed current line properly. 

SRX00315 AMT Change the drawing order of entities in ExpertCAD so that selected entities always draw 
last. 

SRX00316 AMT Implement datum target notes in ExpertCAD that comply with current drawing 
standards. 

SRX00318 AMT Add support for creating datum feature symbol notes in ExpertCAD. 

SRX00319 AMT Revise the geometric tolerance feature control frame icon to make it easier to use and 
more complete. 

SRX00321 K&S Tool Die & 
Manufacturing ExpertCAD does not recognize this IGES file as being a valid IGES file. 

SRX00322 Daman Products When checking for the presence of the default printer in ExpertCAD, check for all 
printers not just those that are local. 

SRX00344 Thumb Tool & 
Engineering 

Dual-dimensions (inch & metric, metric & inch) in ExpertCAD does not work correctly for 
dimensions that include a tolerance. 

SRX00325 AMT 
When ExpertCAD prompts for tolerances for a dimension, check the input to ensure that 
it can be converted to a real number. 

 

SRX00326 AMT 
The thumb wheel icon for switching between check dimensions and theoretical 
dimensions is not working correctly in ExpertCAD when the drawing standard is set to 
DIN. 

SRX00328 AMT Add the ability to import CL data files into ExpertCAD. 

SRX00329 AMT The tilt-wheel mouse event is not being handled by ExpertCAM. 

SRX00331 Philadelphia 
Mixing Solutions Error in the computation of MOI of a tube.  Hollow portion is not being handled properly. 

SRX00336 AMT The folders for the user interface macros distributed with the products should be 
installed in the Program Files tree instead of ProgramData. 

SRX00337 AMT Exporting 2D DXF & DWG files from ExpertCAD 3D is failing if the All Views option is 
enabled. 

SRX00340 AMT The switch for settings in the Adobe PDF dialog to output flow lines for surfaces when 
writing an Adobe PDF file from ExpertCAD 3D is not functioning. 

SRX00351* iFS Building 
Systems The break-line icon is not functioning properly. 

SRX00352* Hiden Analytical Can't define more than 64 standard notes. 

SRX00353* AMT Incorrect error is output when setting a line style. 

SRX00354* gromaTec WinPlot fails when more than 256 plotcap entries are defined. 

SRX00355* AMT File/Plot/Current Class does not work if the class is a line style. 

SRX00356* AMT WinPlot ignores line style 10 definitions. 

SRX00357* Bernal The break-line icon is not functioning properly. 

SRX00359* Bernal Text edit icon leaves the edited text current. 

SRX00360* Bernal The puttext dialog has the previous text as a default instead of no default. 

SRX00362* AMT Automatically update USB licenses to the latest version on install. 

SRX00363* Bernal The command searchtext fails if searching for a null string. 
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SRX00364* AMT The file dialog for specifying a backup file is not working correctly. 

SRX00365* Bernal Make the text buffer HOME read & write. 

SRX00366* AMT Disabling automatic backup is not working correctly. 

SRX00367* AMT Can’t read an ExpertCAD file > 4GB in size. 

SRX00368* Fontaine 
Engineering Can't write an ExpertCAD drawing that will be > 4GB in size. 

SRX00369* Fontaine 
Engineering Problems reading AutoCAD files containing block names with double byte character(s). 

SRX00372* AMT Coordinates in the status bar are incorrect for very small zoom scales. 

SRX00373* Fontaine 
Engineering Symbol for a locked entity is not being drawn to the screen. 

SRX00374* Bernal Certain construction line icons do not draw the line after creating it. 

SRX00375* AMT The ‘? r <file>’ ScriptLink command is failing for open and locked files. 

SRX00376* Fontaine GmbH Problems reading AutoCAD files containing block names with double byte character(s). 

SRX00377* Hiden Analytica Certain construction line icons do not draw the line after creating it. 

SRX00378* AMT AutoCAD translator unnecessarily limits nesting of block references to 4 deep. 

SRX00380* AMT Settings for Setup/Text Notes are not being saved correctly. 

SRX00382* AMT Disable the Sent to Control menu item if there are no machining sequences defined in 
ExpertCAM. 

SRX00383* AMT Post a confirmation dialog before overwriting a file when post processing in ExpertCAM. 

SRX00385* AMT Custom color settings are not being honored by the AutoCAD translators. 

SRX00386* AMT Insert / New Symbol feature is not working properly. 

 
* Addressed in 2018 Update 1 release. 
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